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STOP!
Did you randomly obtain this document from the web? Make sure you're using the latest
version of this document by checking the CEENBoT Portal located here:
http://ceenbot.digital-brain.info
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WARNING: Before You Begin...
Your CEENBoT may have arrived in your hands with a pre-programmed firmware that showcases some
basic functionality. More importantly, this functionality includes power management and battery charging
capability. This capability is NOT (yet) included in the API. It is very important that you either have a backup,
or have a copy of the original HEX file of the original CEENBoT firmware before you start writing programs with
this API.
At the time this document was being written, the latest firmware can be obtained here:
https://www.ceenbotinc.com/updates
You need to understand that if you wish to restore your CEENBoT to factory settings – for example, you want to
use the CEENBoT to charge your battery after you've done experimenting with the CEENBoT-API – that you
need to re-flash your CEENBoT with the factory firmware (i.e., the aforementioned HEX file). It is assumed that
the end-user understands how to perform this procedure.
With that said, the following warnings should be taken seriously.
WARNING
Keep a backup of your original firmware and know how to re-flash your CEENBoT BEFORE
YOU BEGIN EXPERIMENTING WITH THE CEENBoT-API!
Finally, and most importantly:
NO WARRANTY
THIS PROGRAM (“THE CEENBOT API”) or simply (“API”) IS DISTRIBUTED IN THE HOPE
THAT IT WILL BE USEFUL, BUT WITHOUT ANY WARRANTY. IT IS PROVIDED "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR
CORRECTION.
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW THE AUTHOR WILL BE LIABLE
TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA AND/OR EQUIPMENT OR
DATA/EQUPMENT BEING RENDERED INACCURATE OR USELESS OR LOSSES
SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM OR
DEVICEE TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF THE AUTHOR HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
YOUR USE OF THIS “API” CONSTITUTES YOUR AGREEMENT AND UNDERSTANDING
OF THE 'NO-WARRANTY' CLAUSE.
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The CEENBoT-API: Getting Started with Atmel Studio 7 (TM)
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Introduction: About the CEENBoT-API
The CEENBoT-API is an Application Programming Interface that exposes a set of functions which
allow you to control and manipulate the CEENBoT in a a simplified manner. Its purpose is not necessarily
to completely replace 'bare-metal' programming of the 'BoT, but simply to provide an optional set of tools
that allows the end-user to explore the CEENBoT and its capabilities in a more friendly, inviting, and
open-ended manner. This opens up the CEENBoT for exploration at multiple skill levels for those who do
not wish to be bothered with the intricate details of the CEENBoT's electronics. CEEBoT-API
The CEENBoT-API exposes a rich set of C functions that allows usage of the various hardware
resources available on the CEENBoT itself through simple, well-documented function calls. These set of
functions allow the manipulating of peripherals; some of which include graphic LCD display, on-board
LEDs, stepper motors and more. The API function library is exposed to the user by way of a precompiled
static library. The user merely needs to include the appropriate header files and link against this static
library to take advantage of the rich set of functions.
This 'getting started' document is an important first step on beginning to explore the capabilities of
the CEENBoT-API. It walks you through a tutorial on how to write programs that run on the CEENBoT
which take advantage of the CEENBoT-API. It is very important that you read it from beginning to end.
The knowledge and experience you gain in this tutorial will get you started to writing your own CEENBoT
programs that take advantage of the API. This document is the spring board to programming with the
API, so if this is your first time, then this document is where it all begins. Consequently, it is important
that you read this document through to completion.

Absolute Minimum Requirements
To successfully make use of the CEENBoT-API and be able to write, compile, and upload your
programs on your CEENBoT you are [eventually] going to need the following:
•

Obviously, you're going to need a CEENBoT. This should be platform v2.2x (currently, up to
v2.24 have been tested), with an ATmega324P microcontroller. CEENBoTs with Atmega1284
are NOT [officially] supported. While similar, the API was compiled specifically for the
ATmega324P.

•

A means to program your CEENBoT. This depends on the firmware that is currently installed,
and the tutorial will go further in this particular detail (see 'Prerequisites' starting on pg. 11).
Typically, for new CEENBoTs out of the box, you will need an AVR-ISP programmer. However, if
you've converted your CEENBoT (or it has been converted for you) to make use of the
bootloader, then you'll need to have an USB-to-Serial cable.

•

You will need a Windows-based PC or Laptop, or access to a virtual machine that allows you to
run a legitimate copy of Windows as the software we'll use is Windows-based.

The rest of this document will walk you through additional components you might need as you proceed
with the tutorial parts that follow, and will instruct you about when you will need to download and install
such components.
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Document Conventions
This document uses the following typographical conventions:
•

Code is written using Lucida Console type font. It is typically shown as follows:
void CBOT_main( void )
{
// … code here;
} // end CBOT_main()

•

Sometimes you'll be instructed to access a particular feature by clicking your way through a set of menus.
For example – take a look at the figure below – it is a screen-shot of a completely unrelated program
called Open Office:

I might describe the above operations using the following notation (without the benefit of the image):
“Go to the top menu and select:
[[ Tools > Language > For Paragraph > English (USA) ]]”.
In particular, note how menu-driven directions are enclosed in double square brackets [[ ]].
•

Some panels have buttons, which I will instruct you to click on. For example, the panel below has a
button called New Project:

I might describe the following operation:
“In the “Welcome to AVR Studio 4” panel, click on [ New Project ].”
In particular, note that panel buttons directions are enclosed in single square brackets [ ].
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•

In general when I want to attract your attention to an area on a panel or window on the software you're
looking at, I will use courier new type font to describe such an area. It means you should stop
looking at this document and start looking for the specified feature on your computer screen. For
example, in the same above figure I might say, “under Recent projects, blah, blah”, etc.

Comments, Questions and/or Suggestions...
Comments, questions and/or suggestions should be addressed by e-mail to:
ceenbot.api@digital-brain.info
Check out the CEENBoT Portal for latest development news regarding the API:
http://ceenbot.digital-brain.info
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Start of Tutorial:
Preliminaries, Part I, Part II, and Part III
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Tutorial: Description & Overview
The primary aim of the this tutorial (and of this Getting Started Guide) is to show you the process
required to write 'CEENBoT-API programs' – that is, C programs which make use of the CEENBoT-API
precompiled library. To achieve this goal, this tutorial will walk you through the steps to create a very
simply program that will display the message “Hello, Dolly” (in the spirit of a typical “Hello, World”
program) on the CEENBoT's on-board LCD.

Fig. 1 – What we hope to achieve at the end of this tutorial. Write a simple program display a simple message.

Remember that if this is your first time using the API, it is important that you complete the tutorial in its
entirety. Again, the focus here is on the process and steps required to write any CEENBoT-API program.
Once you learn how to do this, you can use the same process to write your own custom CEENBoT-API
programs.
The tutorial is divided in several parts:
•

Preliminaries: Here we go over basic requirements before proceeding, which mainly consists of
making sure you download and install Microchip's Atmel Studio 7 and download the CEENBoTAPI onto your local machine/PC/laptop.

•

Part I: Shows you how to configure an Atmel Studio 7 project 'template'. Once the template is
created, you can easily start new projects by using this template. This way, we don't have to set
up all the configuration options from scratch. Thus, in this part we configure the project options
for this task, and set up the compiler and linker options for an CEENBoT-API project.

•

Part II: Shows how to start a new Atmel Studio 7 project using our previously created template
(learned in Part I) to write a quick “Hello, Dolly” program to test that our configuration is up and
running.

•

Part III: Shows how to upload the HEX file for the Hello-Dolly program to the CEENBoT via the
AVR-ISP programmer (Part III(a)) or a USB-to-Serial Cable (Part III(b)). Choose the part that is
appropriate, based on the firmware you have installed on your CEENBoT. Those using the newer
CEENBoT Utility Tool with a USB-to-Serial cable need to refer to Part III(b).

You are highly encouraged to read this document in its entirety first before you ACTUALLY do anything.
This 'Getting Started' guide is long because it has been expanded to be more self-contained and
comprehensive, since navigating your way around the CEENBoT regarding how to program it can be
confusing for newcomers and a lot of this information was previously 'spread around'. Also, because
there's lots of pictures. ;o)
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Before You Begin: Prerequisites
Please make sure that you meet the following prerequisites – read the following carefully because not
everything applies, based on what type of firmware you have installed on your CEENBoT:
•

That you have a properly fully-charged CEENBoT, platform 324 version 2.2x series with an
Atmega324P microcontroller. Please note that CEENBoTs with ATmega1284 microcontrollers
are NOT [officially] supported. Albeit similar, the CEENBoT-API was NOT compiled for that
device.

•

That you have a suitable way to program the CEENBoT: the most common 'out-of-the-box'
method for new owners is to program the chip directly with an AVR-ISP programmer, which
looks like the following:

Fig. 2 – Example of an AVR-ISP MkII programming cable (USB version).

Note: Atmel no longer produces the AVR-ISP; however you can still acquire them through
third parties, or 2nd hand (e.g., eBay). Atmel, instead, now uses something they call “ATMELICE” (In-Circuit Emulator), which achieves the same thing and purpose as the AVR-ISP, but it's
more fancy, and of course, more costly.

However, if your CEENBoT's firmware has been updated with a bootloader (you can tell you
have a 'bootloader' if you hear a musical “too-doo-too-tooooo!” upon powering up the CEENBoT),
then you would instead program your CEENBoT by way of the CEENBoT's serial COM port using
a USB-to-Serial cable, which looks sort of like this (with a Serial DB9 COM connector on one
end, and a USB connector on the other):

Fig. 3 – A 'traditional' USB-to-Serial cable. Note we have a 9-pin (DB9) COM on one side, and a USB on the other.
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If (and ONLY if) this is the case, we also use a separate application—which will be assumed to
already be installed on your machine—called the CEENBoT Utility Tool. The CEENBoT Utility
Tool is a stand-alone Windows application that knows how to 'communicate' with a CEENBoT that
has the special bootloader firmware discussed previously.
In any case, many USB-to-Serial cables (while they look like 'just' a cable to you) require a
hardware driver software that is usually provided by the vendor of the cable to be installed on
your computer so that Windows can make use of the cable. Many times, Windows will
automatically recognize the cable, but this isn't often guaranteed, unless the cable is from a
popular brand.
Lastly, to connect the USB-to-Serial cable to the CEENBoT's COM port, you'll also need what is
called a gender-changer, such as the one pictured below:

Fig. 4 – A typical gender changer.

The gender changer would then be 'sandwiched' between the COM port connector on the
CEENBoT and your USB-to-Serial cable as pictured below:

Fig. 5 – The above figure shows where the AVR-ISP cable would connect (by default straight from the factory), versus where the USB-toSerial cable would connect, along with the gender changer (if the the CEENBoT has been properly converted to use the bootloader).

•

That you have a Windows-based PC. The software we will use is only Windows-compatible.
If you don't have a Windows PC, you can often install a Virtual Machine (such as Oracle's Virtual
Box, which is free) and install a [legally-purchased] copy of Windows on that machine. Be
advised that this process, can be lengthy and possibly tedious for inexperienced users. However,
it's often the only choice (especially for Mac users). A non-free Virtual Machine for Mac users
called Parallels is also worth a look.

12

CEENBoT-API: Getting Started Guide with Atmel Studio 7 (Rev. 1.5)
Additional Conventions
Many of the screen shots have numbers in black, designed to attract your attention to a particular region
of the user interface in the numerical order in which these 'features' should be addressed. As you read
each of the steps, you'll see numbers in bold parenthesis (e.g., Select memories... (1), and click the
[Program] button (2)). The numbers are meant to draw your attention to the corresponding screen shot.
The screen shots for this tutorial are based on version 6.1 update 2.0 (build 2730).
Let's begin.
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Preliminaries: Software, CEENBoT-API library, Drivers, etc.
Before starting the actual tutorial parts, we need to fulfill the following preliminaries.
Download and Install Microchip's Atmel Studio 7
The 'official' method to do 'CEENBoT' programming is to use Microchip's Atmel Studio 7 (AS7). This is a
development environment where you'll do all your coding, and (depending on programming method) also
how you upload your programs to the CEENBoT's ATmega324P microcontroller. So:
1. Head over to: http://www.microchip.com/avr-support/atmel-studio-7
Download Atmel Studio 7. There's two versions, a “Web Installer” and an “Offline Installer”. The
Web installer is small in size, but requires that you're connected to the Internet while you install
AS7 on your machine. The Offline installer is much bigger (nearly 1GB in size), but can be
installed “offline” (once fully downloaded), and may be useful if you need to re-install AS7 again if
you're away from the Internet, or to maintain a copy as a backup.
Whichever method you choose, once you start the installer you may be asked the following
questions (sometimes while the installation is in progress):
a) You only need to install support for AVR 8-bit (uncheck “AVR 32-bit” and “ARM”).
b) You do NOT need to install the “Atmel Software Framework” (ASF) component.
c) When asked to install various 'drivers', choose to 'Install' (or say 'Yes').

Note: Please, keep in mind that installation of AS7 can take up to 45-minutes no matter
how fast your machine might be.

Download the CEENBoT-API
Next, we need to download the CEENBoT-API. This is nothing more than a ZIP file, often named along
the lines of capi324v22x-vX.XX.XXX.zip (where the X's are the version numbers). So:
1. Head over to: http://www.digital-brain.info/ceenbot/ceenbot_api.php
Scroll down towards the “Downloads” area and find “CEENBoT-API static library” and click on the
'Download' link to download the ZIP file into a known location on your machine where you'll
ALWAYS have access to it. If in doubt, just put it on your “Desktop”.
2. Extract the contents of the ZIP file.
How you do this exactly depends on what “UN-ZIPPING” application you might have installed on
your Windows machine. Usually double-clicking the ZIP file does job, or right-clicking and
selecting “Extract...”, etc.
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Once you've extracted the contents there should be a folder with the following structure/contents.
Please double-check the following and know where everything is:
(this is the TOP-level folder)
(this is the precompiled static library)
(this is the folder containing all header files
which end in “.h”)

capi324v221-vX.XX.XXX/
capi324v22x.a
lib-includes/

Make sure you keep the top-level folder (and everything in it) in a known location, because later,
when you configure AS7 as you proceed with the tutorial, you will need to specify where the
CEENBoT-API is installed on your computer, and you will need to specify the top-level folder for
the “static library” file, and will also have to specify (separately) the location of the “header files”.
Again, remember these terms: “static library file”, vs. “header files”. These are two different
things, located in different places!

Note: Default Windows installations often hide file extensions by default. So you might not
see the “.a” in capi324v22x.a and you might not see the “.h” in the files located inside the
lib-includes/ folder. Consult the web on how to 'reveal' file extensions on your particular
version of Windows.

(Maybe) Download and Install the CEENBoT Utility Tool
Again... you ONLY make use of the CEENBoT Utility Tool if-and-only-if you have converted your
CEENBoT from its factory default firmware and have replaced it with a bootloader firmware (your
CEENBoT emits a “too-doo-too-tooooo!” musical tones).
If this is the case, then:
1. Head over to: http://www.digital-brain.info/ceenbot/ceenbot_boot.php
2. Scroll down to the 'Downloads' section and download the Windows version of the “CEENBoT
Bootloader Package”. This is also a ZIP file, just like the API.
3. Extract the contents of the ZIP file onto a known location, such as your Desktop.
4. Find the folder called Installer/, and double-click on the executable file to install it. At some
point during the installation process you'll be asked if you want to update the “PATH” on your
system. Make sure you say 'Yes', because this allows the command-line version of the
CEENBoT Utility Tool to also be used using the Windows Command Prompt.
5. When you're asked if you want to install the driver for the USB-to-Serial cable, say “NO” (because
the driver currently packaged in the ZIP file is not up-to-date). This will be discussed in the next
section.
6. At this point the CEENBoT Utility Tool should be ready, and accessible from the Windows start
menu.
You're now ready to begin the actual tutorial. Continue onto the next page to begin.
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(Maybe) Install the latest USB-to-Serial FTDI Drivers
The most popular (and most reliable) types of USB-to-Serial cables are based on the “FTDI chipset”.
They're so popular that usually Windows should automatically detect and install its own FTDI drivers
when you plug in your cable. But, often times even when Windows reports that the cable is “installed and
ready for use”, it turns out that the driver isn't properly installed. How to find out? Well, simply open the
Device Manager tool on your Windows operating system and you might see something like this (you have
to have your cable connected):

Fig. 6 – Using the Device Manager to find out if you have 'driver issues'.

Note that there's an exclamation mark (!) next to “other devices”. This indicates that the driver (that
Windows has) is not properly working (or it's not exactly compatible with your cable). The solution is to
install the driver that was provided with your cable. If you know your cable is (for sure) based on the FTDI
chipset, you can download the latest drivers from here:
https://www.ftdichip.com/Drivers/VCP.htm.
Make sure to select the proper operating system as well as variant (32-bit OS vs. 64-bit OS).
Here's how you would proceed:
1. Extract the ZIP file you downloaded from FTDI into a known location (e.g., 'Desktop').
2. On the Device Manager Panel, right-click on the device with the exclamation icon (see Fig. 6
above) and select 'Update Driver'.
3. When asked whether you want for Windows to search for a driver, or whether you want to
'manually' search for one, select to manually search for one.
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4. When you are asked to find the location of the driver, click the [Browse] button and find the toplevel folder for the ZIP file you extracted and obtained from FTDI. At this point Windows will
install the latest driver.
5. Upon successful installation of the driver you should see that the exclamation symbol is now
gone, and Windows now has assigned your cable a COM port number. (See below figure).

Fig. 7 – The Device Manager showing a properly-installed USB-to-Serial cable driver.

Note: Please note the preceding instructions apply for USB-to-Serial cables based
exclusively on the FTDI chipset. If your USB-to-Serial cable vendor has provided you with a
corresponding driver CD, you should use that instead. However, a similar approach would be
used to update your driver for your USB-to-Serial cable.
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Part I: Setting up an Atmel Studio 7 project Template for a CEENBoT-API Project
1. Start Atmel Studio 7, either by clicking on its desktop icon, or by way of
[[ Start > Programs ]] menu on your Windows machine.
2. Go to [[ File > New > Project... ]] to start a new project.
On the left-hand side make sure you have C/C++ selected (1). The middle column will show the
various project types. Make sure that you click and select “GCC C Executable Project” (2).
Then, for Name: enter CEENBoT-API Project, shown in (3).
If you want to change the destination where the project will be created, click the [Browse] button
to change it (5). Otherwise, leave it at the default. Make sure “Create directory for
solution” remains checked. Then click the [OK] button (6).

Note: The above screenshot shows “GccApplication2” in the 'Name' field, but as
instructed above, make sure you enter “CEENBoT-API-Project”.

3. Next, select the target microcontroller device. The CEENBoT platform 324 v2.2x uses the
ATmega324P, so find this microcontroller and select it. Then click [OK]. (see next page).
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4. Studio will create an empty project with some minimal content. However, we need to change a
few things.:
a) Change:
#include <avr/io.h>
to:
#include “capi324v221.h”
b) Change:
int main( void )
to:
void CBOT_main( void )
c) Lastly, make sure to add the comment header at the top as shown below!
Save what you have thus far by hitting [CTRL]+[S].
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5. Next, we need to configure the project settings, so go to [[ Project > CEENBoT-API
Project Properties... ]] (or press [ALT]+[F7]). You should see the following. Notice
that on the left there are sub-menus called “Build”, “Build Events”, “Toolchain”, “Device”,
“Tool” and “Advanced”:

Let us begin by changing “Configuration:” above to “All Configurations”. This will
ensure settings we apply to our project properties apply equally to both, a RELEASE build, or
DEBUG build. (NOTE: We will ALWAYS build for RELEASE, and not DEBUG.)
6. Next, as shown on the figure on the next page, click on “Toolchain” (1) on the left-hand side,
and under “AVR/GNU C Compiler” select “Symbols” (2). Click on the little green '+' icon,
shown by (3).
An “Add Defined symbols (-D)” requester box appear.
shown in the figure, denoted by (4), and click [OK] (5).

Enter F_CPU=20000000UL as

Note: Make sure you enter 20 million! That's 20 followed by six more zeroes. If you get this
wrong, _delay_ms() and _delay_us() which are standard functions provided by AVRLIBC, as well as certain CEENBoT-API functions that depend on these low-level functions will
NOT work correctly.

20

CEENBoT-API: Getting Started Guide with Atmel Studio 7 (Rev. 1.5)

7. Next, select “Directories” (1) (still under AVR/GNU C Compiler category). We need to tell
the C compiler where to find the header files (*.h files) for the API library. So, once again, click
on the '+' green icon (2) to add a new entry. This will bring up another window. Click on the
[...] button on the right (3) and find the folder 'lib-includes/'. Recall this folder is located
wherever you decided to download and extract the contents of the API library. (Mine is on the
Desktop because that's where I extracted it, but yours might be different).

then click [OK] (4)
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8. Next under “Optimization” (1), select “Optimize for size (-Os)” as shown in (2).

9. Ok. Let us now move to the “AVR/GNU Linker” set of sub-menus, and let's start by clicking on
“General” (1), and check “Use vprintf library (-Wl,-u,vfprintf)” as shown (2).

22

CEENBoT-API: Getting Started Guide with Atmel Studio 7 (Rev. 1.5)
10. Next, click on “Libraries” (1) and click on the '+' green icon (2) to add a new entry and when
the window appears, type either libcapi324v221 or libcapi324v22x (depending of which
you have in the ZIP file you extracted [go look!] as shown (3), then click [OK] (4).

Repeat the above steps to add libm (if not listed already) and libprintf_flt. That is, click
the '+' button (2), enter the library name (3) and hit OK (4). The top side should have the
following libraries listed in this specific order:
libcapi324v22x (or libcapi324v221, depending on the file name in the ZIP)
libprintf_flt
libm
If this is NOT the order, use the UP/DOWN yellow arrow icons (in the vicinity of (2) by first
selecting the file name, and then using these icons to move their order.
11. Next, while we're still on this same sub-menu, click on the other '+' green icon marked as (5...).
This will bring up another window. Click on the [...] to find the location where the
libcapi324v22x.a (or libcapi324v221.a) file is located. Remember this is located
wherever you decided to download and extract the API library. Click [OK].
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Upon completion you should see something similar as shown in the below figure. On the top
area we have a list of libraries that we're going to link against, and on the bottom part we have the
paths to the location of these libraries. Since the CEENBoT-API is the only “custom” library we're
using, this is the only library whose “location” or “path” must be manually specified by hand. The
linker already knows where to find the other libraries (libprintf_flt and libm) because
these are packaged with the toolchain.

Note: It is VERY important that the libraries are listed in the ORDER shown above. This is
because their order reflects their 'dependencies'. There 'stuff' inside of the libcapi324v22x
library that 'depends' on stuff in 'libprintf_flt'. In the same vein, there's 'stuff' inside
'libprintf_flt' that 'depends' on stuff in libm (the math library). Order is crucial!

12. Let's save what we have so far and hit [CTRL]+[S]. Then, go ahead and close the properties
window by clicking on the “X” on the yellow tab.

This should take you back to the source code window.
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13. Next, we need to test that the project can build successfully, so on the top menu, select
[[ Build > Configuration Manager... ]]. A new window will pop up. Under “Active
solution configuration” select “Release”. Then click the [Close] button.

14. Hit [F7] to build (compile, link and generate the HEX file) the project. Alternatively you can go to
[[ Build > Build Solution ]].
IF you did everything correctly, you should see the following output along the bottom portion of
Atmel Studio 7 automatically pop-up. If you don't see this you may see an 'Error List' window
appear instead (along the bottom). If the 'Output' window does NOT show at all, simply go to
[[ View > Output ]]:

In any case, here you are looking for two things: 1) That the build succeeded, and 2) that there
are 0 failures. Hit [CTRL]+[S] one more time to make sure everything's saved.
15. Next, go to [[ File > Export Template... ]]. You should be presented with the
following (see next page). At the bottom where it says “From which project would you
like to create a template?” it should already be set on “CEENBoT-API-Project”.
Also make sure that “Project template” is selected.

25

University of Nebraska-Lincoln

Go ahead and click [Next>].
16. Under “Template name:” it should already say “CEENBoT-API-Project”. Under “Template
description:”, please change it to :
“CEENBoT-API C Project”.
Make sure
“Automatically import the template...” is CHECKED! Then click [Finish].
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17. Go to [[ File > Close Solution ]] to close the current project. Remember that we're not
creating a new project to write code (not yet). We've created a new project to derive a template
we will re-use over and over so that we don't have to do everything that we just did all over again.
Then CLOSE Atmel Studio completely, and then RE-START it again.

Part II: Testing our newly created CEENBoT-API Project Template
Let us now see if our project template works.
1. Go to [[ File > New > Project... ]]. You should now see that “CEENBoT-API
Project” (2) should be listed as one of the options so long as you have C/C++ (1) selected on
the left-hand side column:

Go ahead and type “HelloDolly” (no spaces) next to Name: as shown in (3). If you so desire,
select the location where the project will be created by clicking on [Browse...] as indicated by
(4). Leave “Create directory for solution” checked (5).
Finally, click [OK]. (6)
2. Set the configuration build mode to
RELEASE. You can easily do this via the
toolbar menu (see right):
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3. A new project will be started. It may happen that the the source-code window is not shown by
default. You can bring it up by double-clicking on “CEENBoT-API Project.c” (possibly called
main.c in Atmel Studio 7) under the Solution Explorer window way to the right (1).
(Sometimes it's on the LEFT side)

Go ahead and MANUALLY enter the code shown on the left side (2), which is also given on the
next page.
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Note: Please DO NOT COPY/PASTE!!! – this causes issues EVERY time due to hidden
meta-characters in PDF that are copied into the editor, which gives 'inexplicable' compiler
errors! You need to start memorizing this 'stuff', and the best way to do that is by manually
typing code.

Listing 1 – Simple source code to test our CEENBoT-API Project Setup.
#include “capi324v221.h”
void CBOT_main( void )
{
// Open the LCD subsystem module.
LCD_open();
// Clear the LCD display.
LCD_clear();
// Say “Hello”.
LCD_printf( “Hello, Dolly!\n” );
// Loop forever.
while( 1 );
} // end CBOT_main()

4. Once you've typed the code into the editor area, go ahead and hit [F7] to build the project and
look at the output window messages at the bottom of Atmel Studio 7.
Again, we're looking for two things: that the build succeeded, and furthermore, that there were
NO failures/errors. If you have errors, read on the next page for the most likely (and most
common cause).
That's all there is to it. Life's much easier with project templates. Keep on reading to learn how to go
about uploading your program to the CEENBoT.
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NOTE: Issues that are Atmel Studio 7-specific
It turns out that in the last step of the previous page when you build the project by hitting [F7], you might
see an error in the output window area along the following lines:

This error is due to bug that is specific to Atmel Studio 7. The issue is that some of the settings that are
supposed to be 'remembered' when you saved the project template that you created in Part I of this
document are simply 'forgotten' when you start a fresh new project that is based on the project template
you created in Part I.
To fix this issue you need to perform the following:
1. Open the project settings of your current project by hitting [ALT]+[F7].
(Just to be clear, we can't fix the project template. Your 'template' is correct. What we're going to
fix is the project itself you just created [based on your template])
2. Select Active Configuration to be “All Configurations”. This was shown in step (5) of Part I.
3. Repeat steps (8), (9), (10), (11) of Part I (starting on pg. 22). That is:
a) Set optimization to “-Os” (noticed it changed to “-O1”).
b) Specify all the linker libraries (e.g., libcapi324v22x, libprintf_flt, and libm, in that
order. Notice how we 'lost' most of the libraries).
c) If lost, also specify the library paths.
4. Save your current project settings [CTRL]+[S].
5. Rebuild again to make sure the errors are gone by hitting [F7].
Sadly, this 'issue' prevents us from fully taking advantage of the usefulness of the project template in the
first place, but there's no fix from Microchip/Atmel as of yet.
One possible solution is to perform EVERYTHING that you did in Part I, but skip steps (15) and (16) of
Part I and simply SAVE the file. Then, make a copy of the folder and ALL its files (should be called
“CEENBoT-API-Project”) every time you want to start a NEW project, but DO NOT CHANGE any of the
filenames INSIDE. Instead, ONLY CHANGE THE FOLDER NAME.
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Part III (a): Uploading your Program to the CEENBoT via AVR-ISP
Note: Only read this section if you use the AVR-ISP cable for programming your CEENBoT.
For users making use of the Bootlader with the CEENBoT Utility Tool with corresponding
Program Loader upgrade and USB-to-Serial cables, you must follow instructions provided by
those tools for using to upload your HEX file that way instead. If you have the Bootloader and
use the instructions here you'll end up erasing your Bootloader and Program Loader! You
know you have the Bootloader & Program Loader installed when you hear the musical notes
“Too-doo-too-tooooo!” (C-major chord). If, instead, you just hear two basic short beeps, then
you have the factory firmware, at which point you can proceed with the instructions that follow.

Let us now attempt to upload the program we just previously built to the CEENBoT. Provided you
successfully completed part II, there should now be a HEX file containing the raw binary program in
human-readable ASCII form. This file (which has an extension of .hex) is placed inside of your project
directory (specifically, in a sub-folder either called Debug/ or Release/, depending on whether or not
you remembered to set the build mode), so it is important that you can locate the path in your directory
where you created the Hello Dolly project from part II.
Let's begin:
1. Make sure your AVR-ISP is connected to your PC
via the appropriate interface (i.e., USB or Serial).
The one shown on the right is the AVR-ISP MkII,
which connects to a USB port. Yours might be
different.
2. Connect the cable to your CEENBoT as shown
below (please NOTE the orientation of the red
wire that is part of the ribbon cable:
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3. While we're here, right above where the ribbon cable connects, there is a small header with three
pins as shown, labeled J2:

Although difficult to see from the above figure, one of the pins is full exposed, while the remaining
two are not. Next to this 3-pin header are the labels “Tiny” and “Mega”. Your mission – should
you choose to accept it – is to make sure that the two pins next to where it says “Mega” are the
ones covered by the black “Jumper”, while the lower pin, next to where it says “Tiny” remains
exposed.
Forgetting to have the jumper (as just described) properly set can be a source of trouble as we try
to access and program the MCU with the AVR-ISP programmer, since this controls which
microcontroller is accessed by the programmer.
Note: The names “Tiny” and “Mega” are references to the two microcontrollers on the
CEENBoT's main board, corresponding to the ATtiny48 and the ATmega324P respectively.
Since we're uploading our program to the “Mega”, we need to make sure the jumper settings
just described above is properly set.
4. Go ahead and Turn the CEENBoT ON.
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5. Start the Device Programmer utility by clicking on the icon shown below:

6. The following window should appear:

Notice there's not much to look at yet.
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7. Under Tool, go ahead and select your AVR-ISP programmer. Provided that its drivers have
been properly installed and it is detected by your version of Windows, you should see something
similar, but with a different ID number. Go ahead and select that as shown.

Under Device, select ATmega324P.
Under Interface, select ISP (if not already selected).
Click [Apply].
Note: After you click [Apply] you may be prompted to upgrade your AVR-ISP programmer's
firmware. If so, please proceed with this operation and click [Upgrade]. Once it says that it
has “successfully upgraded”, click [Close]. This means you will have to go back to selecting
the Tool, Device, and Interface, and click [Apply] again.
8. Once you click [Apply] a series of configuration options will become available. You now see
the Device Programmer panel come to life.
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9. Select “Device information” (1). Then, on the top, where it says “Device signature”,
click on the [Read] (2) button right next to it. If your AVR-ISP is working properly, and your
CEENBoT is turned ON, you should see the following:

In particular, you should see “Reading device ID ... OK” on the bottom of the panel.

Note: It is very important that you can successfully read the device signature. If this step fails
(for whatever reason), there is NO point in going further. Failure to read the device signature
can be caused by any number of issues: your CEENBoT may not be powered ON, or
sufficiently charged; AVR-ISP programmer firmware may not be up-to-date; AVR-ISP
programmer is defective; AVR-ISP connector is not plugged in all the way; ...or it may be
plugged backwards; AVR-ISP connector may be worn off from wear-and-tear effects; your
ATmega324P MCU may be 'bricked' or fried; Or you forgot to place the jumper on J2 on the
“Mega” (where it should be) as opposed to the “Tiny”. Again... it could be ANYTHING.

10. Okay. At this point we're ready to upload. Go ahead and click on Memories on the left-hand
side column (1). You should see the following panel options. (See next page):
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Next, click on the [...] button (2) to find and select the HEX file that was generated when you
built (i.e., compiled) your project.
For our Hello Dolly project, I had called it
HelloDollyTest.hex. Also note that while the above screenshot shows me pulling my HEX
file out of the Debug/ folder, you should have selected Release as previously mentioned in step
2, of Part II of this document, and thus, your HEX should be pulled form the Release/ folder
instead. This can be a source of trouble, if (in Part II) you forget to set the 'Active Configuration'
you may sometimes built a HEX file under 'Debug' and sometimes under 'Release', and you will
be confused by what your robot does because you may be trying to program your robot with a
HEX file that is 'out of date' to what your source code represents! Before you look for the HEX file
you should take a look at your project settings to see what is your 'Active Configuration' prior to
you hitting [F7] to build it.
Once you find it, click the [Program] button. (3) Wait for the upload to take place. Keep a close
eye at the status messages at the bottom of the panel (4) and make sure that everything says it
went “OK”.
When you're done, click [Close]. (5)
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At this point your CEENBoT should automatically reset and run your program. (If not, just push the Reset
button on your CEENBoT), at which point you should observe the following:

Here's a close up.

...and that, my friends, is it.
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Part III (b): Uploading your Program to the CEENBoT via USB-to-Serial Cable
Note: The information that follows is ONLY valid for CEENBoTs that have been converted to
make use of a bootloader firmware called the Program Loader. You know you have this
bootloader installed if, when powering up or resetting the CEENBoT, you're greeted with a
musical “too-doo-too-toooo!” sound. If you just hear two basic (boring) 'beeps', then you do
NOT have the bootloader install, and you should NOT proceed any further – you should be
following the instructions from Part III (a) instead!

Assuming you have installed the CEENBoT Utility Tool as discussed starting on page 15, you would
proceed as follows:
1. Connect the USB-to-Serial cable and gender-changer to your CEENBoT (on one end) and your
computer's USB port (on the other), as shown below:

2. Start the CEENBoT Utility Tool. It should look as shown on the following page.
3. Click the [Select File] button, and find the HEX file for your Hello-Dolly project.
You can find it inside your project folder, either under Debug/ or Release/ depending on the Active
Configuration you had set when you compiled and built your project (i.e., when you hit [F7]) in
Part II.
4. Click on the [Assign Name] button.
A pop-up text field Panel will appear, asking for a very brief name or description. Just enter
“Hello Dolly” (without the quotes), and click [OK].
5. Pick a 'slot' from the 'Select Slot' drop-down menu. This is where your program will be
stored. If there's already an existing program on your selected slot (which you can only tell by
looking at your CEENBoT), then that program will be overwritten by the new one.
6. Select a 'baud' speed from the 'Select Baud' drop-down menu. Aim for the fastest speed, and
if for some reason that doesn't work, try again with a slower speed.
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The CEENBoT Utility Tool main areas: (1) Menu bar; (2) Upload controls, (3) Status, (4) Output window.

7. Click the big [Upload] button, and wait for your HEX file to be uploaded to the CEENBoT.
8. Disconnect your USB-to-Serial cable.
9. You do NOT need to RESET your CEENBoT. Simply use the CEENBoT's buttons to navigate to
the slot number you had previously selected. You should see “Hello Dolly” on the slot you
had chosen on your CEENBoT's LCD, and click the [^] button (middle button).
10. Your CEENBoT should be running your new program and you should see the following.

And that's it!
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That was fun! What, Next?
Now that you've gone over the 'basics', the next step is to explore the capabilities of the CEENBoT-API
further. For this, there's various resources you can explore. To further learn about all CEENBoT-API
related software technologies, you should pay a visit to the CEENBoT Portal:
http://ceenbot.digital-brain.info
This is the 'entry' point to everything CEENBoT-API related, on the software side.
Next, you'll want to explore additional documentation that specific to the CEENBoT-API, which, once
again, is located here:
http://www.digital-brain.info/ceenbot/ceenbot_api.php
Once there, you should look at the 'Downloads' section and check out the following documents:
•

The CEENBoT-API Programming Fundamentals: This brief document explores some of the
basics features of the API that you'll likely want to get a handle as soon as possible. For
example, it discusses some of the most important LCD functions, some of the most important
LED functions (for manipulating the LEDs), as well as how to control the tone generator for
emitting basic tones, but most importantly, it points you to the most significant motion-functions,
because after all, the robot has wheels and you'll want to move it around.

•

The CEENBoT-API Programmer's Reference: This 250+ page PDF is jam-packed with ALL of
the functions that are provided by the static library API. It is a 'reference'. Meaning, it lists ALL
the functions that are supported by the API, grouped by subsystem modules (e.g., LCD, LED,
STEPPER motors, etc), the parameters that the functions take and their values. If you find
sample source code and are curious about a given function or what it does, this is the manual to
look into to find out about it.
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